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Exploring Protein Interaction Networks with
MiMI Plugin to Cytoscape

This tutorial assumes that you have already:
e Installed Cytoscape to your desktop (from cytscape.org)
o Downloaded the following plug-ins — following Cytoscape directions:
MiMI plug in (under Network and Attribute 1/0)
Cytoscape Tutorial (under Theme, includes BINGO and MCODE)
Enhanced Search (under Analysis)
Shortest Path

Getting Started

Accessing the Datasets to Explore with the MiMI Plug in for Cytoscape

Two datasets and one Excel spreadsheet are used in this tutorial. Please download them from:
http://portal.ncibi.org/gateway/ws_resources.html

Dataset 1. Seven differential genes for Part 1 associated with iron.
They include:

CP

HFE

SLC39A14

FTL

LCN2

TF

UGT1A1

These 7 genes (human orthologs) are significantly associated with iron homeostasis and heme
metabolism (Fisher’s exact score for term enrichment) — both of which have been implicated in
prion disease. The genes are from Hwang et al's (2009) list of 333 candidate genes for
susceptibility to prion replication and disease, derived from experiments with mice and microarray
analysis to find differentially expressed genes. Five of the 7 (all but LCN2 and UGT1A1) are in the
“short list” of 32 genes that Hwang et al found to be differentially expressed in all 5 strains of the
prior-infected mouse brains.

Notably, none of the 333 candidate genes associated with cholesterol and sphingolipid metabolism
was found to be differentially expressed in all 5 strains. Yet cholesterol and sphingolipid metabolism
are critical to prion replication.

In this tutorial, you will explore if some connection can be found between iron homeostasis and
heme metabolism, on the one hand, and cholesterol and sphingolipid metabolism, on the other.
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Dataset 2. Fifteen differential genes for iron and sphingolipids

CpP TF SPGL1
HFE UGT1Al1 EDG3
SLC39A14 NPC2 SOAT1
FTL BAGALT1  ABCAl
LCN2 PLD4 APOD

Excel Spreadsheet. GO concepts distinguishing the gene in Dataset 2. You will import this
file to Cytoscape and use it for color coding.

Background Problem, Purpose and Tutorial Objectives

Biology Problem and Purpose of Your Analysis

This tutorial shows how Cytoscape and the MiMI Plugin reveal interactions among gene products
and how to group interactions to uncover fundamental processes relevant to prion replication and
disease.

Background information about prion disease: Neurodegeneration proceeds from accumulation of
PrPSc in cholesterol rich lipid rafts to early synapse degeneration to nerve cell death.

“Dynamic perturbations of gene expression associated with biological processes occur in a
specific order, [reinforcing] that neuropathological changes proceed in a stereotypical set of
steps (Bouzamondo-Bernstein et a/, 2004). Among the first detectable expression changes
(10 weeks) [in prion susceptibility are] increases in mRNA levels of CIga/band C3arl
reflecting activation of microglia and astrocytes, one of the earliest detectable responses to
prion infection (Klein et a/, 2001) (Fig. 4B, module 1). Around the same time, the increased
activities of lysosomal proteases [are] suggested by elevation of the lysosomal protease
gene Ctsc (Fig. 4B, module 2): lysosomal proteases may have a role in degradation as well
as formation of PrPSc (Zhang et a/, 2003). Changes within the lysosomal module [may
become] more obvious at later time points.

“[Also present are ] dysregulation associated with the synthesis, trafficking and processing
of cholesterol and sphingomyelin, two of the major components of lipid rafts where the
initial steps of PrPSc replication are thought to occur (Simons and Ehehalt, 2002). At 10
weeks changes [have been] detected in expression of genes controlling trafficking and
conversion of cholesterol and sphingomyelin (Rodriguez-Agudo et a/, 2008). At 14 weeks
expression levels of cholesterol synthesis genes, such as Mvk and Mvd ... decrease, but
expression of the cholesterol transporters or acceptors including Abcal, AZ2m, and Apod
increase...Decreases in expression of genes involved in cholesterol biosynthesis are
particularly pronounced in mice infected with the RML prion strain.

“Changes in sphingolipid metabolism, potentially leading to a decrease in
galactosylceramide, which is found in PrPSc deposits (Klein et a/, 1998), are evident by 18
weeks. An increase in GAG metabolism, indicated by increased Gusb and Hexb mRNA
levels, [is] first detectable at 14 weeks (Mayer-Sonnenfeld et a/, 2005).”
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Summary points:

Androgen metabolism may be involved in prion disease as it is tied to glial activation.
Microglial activation and reactive astrocytic gliosis reflect responses to accumulation of
PrPSc and are one of the earliest detectable responses to prion infection.

Iron homeostatis and heme metabolism may play a complicated role. Activation of the heme
degradation pathway in the brain has been associated with cellular response to oxidative
stress. Regulation of protective functions against oxidative stress through iron homeostasis
is essential for maintaining oligodendrocytes and myelin the brain. Dysregulation may relate
to demyelination in prion disease

Additionally, increased activities of lysomal proteins may play a role in degradation as well
as in the formation of PrPSc (abnormal disease-produc8ing protein).

The control and conversion of cholesterol and sphingomyelin are also implicated in prion
replication. A decreased expression of genes involved in cholesterol biosynthesis has been
pronounced in mice infected with prion disease. Dysregulated cholesterol metabolism may
be coupled to the perturbation of neurosteroid metabolism. Furthermore, a close physical
relationship among cholesterol, sphingolipid metabolism on lipid rafts in the plasma
membrane, and galactosylceramide (GAG) found in PrPs deposits seems to be necessary
for prior replication.

Reference:

Daehee Hwangl,Inyoul Y. Lee, Hyuntae Yoo, Nils Gehlenborg, Ji-Hoon Cho, rianne Petritis ,
David Baxterl1, Rose Pitstick2, Rebecca Young2, Doug Spicer2, John Hohmann4, Stephen J.
DeArmond3,

George A. Carlson2t, Leroy E. Hood (2009) Dynamical prion disease networks. Forthcoming

Objectives: In this Tutorial you will:

Part 1

» Query on a list of genes

» Set up views to facilitate exploratory analysis, e.g. layouts, selection

» Explore details to conceptually characterize gene products and interactions
» Expand a network node (gene product) to see additional direct interactors
» Find literature associated with interactions to help verify the interactions

Part 11

» Read in additional values related to the genes on your list

» Color code nodes by a selected attribute

» Link out to details, supporting literature, and subgraph matches with KEGG

» Find shortest paths between 2 genes and identify the mediating gene products
» Create network clusters and explore their traits
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Opening Cytoscape and Querying on a Gene List

Steps

1. Open Cytoscape by clicking its icon on your desktop.

2. Go to the top menu: click Plugins = MiMI Plugin = Query.
A query dialogue box appears.

3. In the dialogue box, click From File tab = Load gene file. Select the first dataset that you

downloaded to your desktop comprising iron-related genes. Click Open. A parameter setting
dialogue box appears.

4. Leave all the defaults intact. Press Search. Cytoscape displays the 7 genes, their direct
interactors, and interactions between the displayed genes.
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Figure 1.

4. Set up the display information about the connected gene products by doing the following (as
highlighted in Figure 1):

a. Click on the Network tab in the left hand panel to display the view shown in Figure 1.

You see that a total of 102 gene products are displayed (the 7 genes on your list plus their
interactors).
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b. Size the network pane so that it fills the whole display window.

c. Select all nodes by making a box around them with your mouse (Alternatively, hold down
Control+Alt+A). The nodes become highlighted as yellow to indicate selection. Edges are
red.

d. Click on the Table icon in the lower Data Panel (directly under the word ‘Data’) to select
data attribute fields to display. A pop up check list appears.

e. On the pop up, check: Component, Description, Function, Gene name, Pathway.
f. Click anywhere outside the pop up box to close it.

g. Information fills the data panel. Drag column headings to re-order the columns.

h. Zoom in by clicking the magnifying glass with the plus. The lower left blue translucent

box in the Network tab (left) gets smaller. Move this box across the network context with
your mouse to pan across the large network view.

Exploring Results on Interactors with Iron-Related Genes

Steps

1. Look for pathways associated with the iron-related genes that may be related to sphingolipids or
cholesterol. Click the column heading Pathway to sort alphabetically. Scroll through the list.

To scan more easily, undock the table from the Data Panel and expand it. Click the “docking
icon.” Maximize the table. To dock it again, click the icon.

See Figure 2.
DEmE;e[ﬁ Click the docking icon to undock the tableLJ
o [ Gene Nare l Description ] Pathway [ Component
1 ADHT | alcohol dehydrogenase 7 (class V), ... | Glycolysis / Gluconeogenesis [path:hsal0010); Fatty acid metabolism [pathch... | cytoplasm [G0:0005737)
(7872 | ADHFE1 | alcahal dehydrogenase, iron containi.. | Ghicolysis f Gluconeopenesis [path:hsal001 0}, Fatty acid metabolism [pathch. |
118 | ADHS | alcohol dehydrogenase 5 (class I, ¢... | Ghycolysis f Gluconeogenesis [path:hsa00010); Fatty acid metabolism [pathch... | cyloplasm [GO.0005737]
og B3GALT1 | UDP-GathetaGlcNAc beta 1,3-galact... | Gly i by thesis - | ies || 1}; Glycan struc... | Golgi apparatus [GO:0005794]; Golgi ...
36 LRFZ | low density | in-related protein. . | Hedgeh ling pathway [pathhsa04340] apical plasma membrane [GO:00163
37 | TFRC | transferrin receptor (p30, COT1) | Hematopoietic cell lineage [path:hsal4640] | cytoplasmic memnbrane-hound vesicle...
18 MMPS malrix metallopeptidase 9 (gelatinas Leukocyte fransendothelial migration [pathchsa04670]; Bladder cancer [path extracellular region [GO:0005576); extr.
Figure 2a. Docking icon.
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Figure 2b. Full Table View, Undocked. Click the docking icon to re-dock it in the Data Panel. Use
the horizontal slider at the bottom of the table to view all the columns.

2. The pathway of one gene, ARSD, interests you: Androgen and estrogen metabolism
[path:hsa00150]; Sphingolipid metabolism [path:hsa00600]. You now focus on this gene.
Redock the table by clicking the docking icon.

3. Click on ARSD in the table to see where it is in the network. Its node turns green. Zoom in to see
its neighbors. It is hard to see interactors because of the many crossed edges (links between
nodes). Try a different layout.

4. To change the layout, go to the top menu and click: Layout - Cytoscape Layout - Edge-
weighted Spring Embedded 2> All nodes - (unweighted). A new layout appears (See Figure
3).
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Figure 3

5. Zoom in on ARSD with the magnifying glass with the + . You also can zoom with Right-mouse-
down + Slide-mouse-across-screen. Use the translucent blue box to pan the graphic.

You see that a diamond node is linked to the green ARSD node. Hover your mouse over the
diamond. It is UGT1A1, one of the iron-related genes.

Verify Interactions by Finding Literature About Them

Steps

1. Still in the same view as above, verify if interactions between ARSD - with sphingolipid
metabolism implications - and UGT1ALl — an iron association — are covered in the research
literature.

2. Follow the steps in Figure 4.
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Figure 4

3. The Edge Attribute information shows no literature for the ARSD- UGT1AL1 interaction. There is
one PubMedID for B3GALT1 - UGT1A1 from the curated GRID database [PMID:12925779].

You look up the article and find Sprong et al (2003) Association of the Golgi UDP-galactose
transporter with UDP-galactose:ceramide galactosyltransferase allows UDP-galactose
import in the endoplasmic reticulum. This article tells you that the proteins are co-
immunoprecipitated. You are encouraged.

ARSD is more promising a lead since it has more interactors than B3GALT1. You will keep focusing
on ARSD.

Verify Interactions by Finding Literature About Them

Steps

1. On the same view, you now want to see all of ARSD's direct interactors. Click on ARSD to select
it. Then go to the upper menu and click: Select > Nodes > First neighbors of selected
nodes. Its neighbors turn yellow. Drag ARSD out to see the interactors better. Scan the table,
which now displays annotation data on only these selected genes. Nothing particularly interesting
jumps out at you.
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Figure 5

Try one more way of checking out potential connections between sphingolipids via ARSD and iron-
related genes and interactions.

2. Double click ARSD. It expands to all nearest neighbors that are known about it in the MiMI
database (See Figure 6). The set up has to be repeated.

3. To set up the graphic, follow the steps in Figure 6.
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Figure 6
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4. When the view is set up, click back to the Node Attribute Browser tab in the lower tabs beneath
the lower Data Panel. Zoom in and use the translucent blue box (lower left) to move to ARSD.
ARSD is designated by a triangle as shape-coding for nodes you expand to their neighbors.

5. Select ARSD and its newly expanded neighbors by drawing a box around them. They turn
yellow. ARSD is now a triangle — the shape that indicates that this is a gene that you have
expanded. You can collapse the expansion by clicking on ARSD again.

6. The details of the selected gene products appear in the Data Panel table below. For these
neighbors, you now see a number of Sphingolipid-related connections. Inferring that a
connection may be possible, you decide it is worth querying on both the iron- and sphingolipid-
related genes from the Hwang et al study at once together to find connecting links.
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Figure 7

Querying on Iron- and Sphingolipid-related Genes Together

Steps

1. Run a new query. On the top menu, click: Plugins >MiMI Plugin = Query.

2. In the query dialogue box, click the From File tab > Load gene file.

Load the second dataset that you are using for the tutorial —“HemeANDSphingolipidGenes.txt”

Click Open. A parameter setting dialogue appears.

3. Keep all the defaults intact and pull down the Retrieve options. Select “Query genes and nearest
neighbors.” Click Search. The network appears (Figure 8).
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Figure 8. Query Results from the list of iron- and sphingolibid-felated genes — before set up.

4. Set up the view as you did above in Part 1 (repeated below).

a. Click on the Network tab in the left hand panel to display the view shown in Figure 1. You
see that a total of 175 gene products are displayed (genes on your list plus their

interactors).
b. Size the network pane so that it fills the whole display window.

c. Select all nodes by making a box around them with your mouse (Alternately use
Control+Alt+A). The nodes become highlighted (yellow) to indicate selection. Edges become

red.

d. Click on the Table icon in the Data Panel under the network view to select data fields to
display.

e. Choose these fields: Component, Description, Function, Gene name, Pathway.

f. Click anywhere outside the list to close it.

g. Information now fills the data panel. Drag column headings to put the columns in an order
you like.

h. Zoom in by clicking the magnifying glass with the +. The blue translucent box in the
Network tab (left) gets smaller. Move this box with your mouse to pan across the network.

i. Lay out the graph in Weighted Spring Embedded form: : Layout - Cytoscape Layout >
Edge-weighted Spring Embedded > All nodes - (unweighted)
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Looking for Connections Between the 2 Types of Genes

Steps

1. Locate ARSD in the graph that you just set up. Type ARSD in the ESP search box and press
ENTER. ARSD turns yellow but it is hard to find it.
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Figure 9.

2. Under the menu bar is the toolbar with shortcut icons. Click the blank magnifying glass (circled
in Figure 9). This magnifying glass lets you zoom directly into the item you selected — ARSD. See
Figure 10. The zoom is so close that you lose your context in the large network and cannot find the
translucent blue box in the context view in the left hand Network tab.

- ST

& Cytoscape Desktop (Session: CytoPrionTutorial3_part2.cys)

Return to un-zoomed view

Fle EdR View sbelegt Layout Plogse—ioh

= a(ak a@e |

Control Panel T =12l
Tt Metwork | vatpapper®e| Ceretral | Edtor | ..{ <] v

CP HFE SLCI5 A14. . JH175(1) 565(8) Zoomed In Vla a
Zoom out to click of the blank

see context & magnifying glass
the blue pan RS D
box \

L

Figure 10.
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3. To re-orient, zoom out a little. Click the magnifying glass with the minus (-) repeatedly. You now
zoom out enough to see context and to have the blue translucent box reappear.

4. Move the blue translucent box to pan the graphic and see what gene products interact. Any time
you want to see data on a given node, click it: The node turns yellow and information about it
appears in the Data Panel. Shift+click items to see information about all of them at once.

5. You see that the thicker strip of genes (pointed to with an arrow in Figure 11) seems to relate
roughly to lipid metabolism in some way. The lower genes (the zoomed in view in Figure 11)
pertain to iron.

& Cytoscape Desktop (Session: CytoPrionTutoriald_partZ.cys) =10f x|
Fle Edk View Seleck Layout Hugns Help

'&E@.QQ@.@I [ seen | - 8

Confrol Pane| e o
s Natwork| ytapper Icmw\mvl J_
Histwork
CP HFE SLCI9AL4...[H1 7 I'|

SRS

Di\gﬁ_ﬂonds are iron-
~_r1elated genes
/..,--'Trem_ the query list

Thicker strip has
many lipid-related

gene products N ) O
Diata Panal [
| HO8 E=]
Furction Process Pathway | Companent
" plide | binding [GO-0005488); fernic iron binding (GO.0008. | cellular iron lon nomeostasis [$0/0006879], iron io. | | Teritin compléx [G0.0008043)

Box shows the portion displayed in the large network

Mads Attribute Bromser | Edge Aktrbute Brovsar | Network Attribute Browser | Parallel Coordnates | VistaClara |
Welcome to Cytoscaps 2,6.0 Right-chck + dag o 2008 Maddle-chick + drag to PAN

Figure 11.

5LC39A14...|Homo sapiens | All Molecule Types|All Data Sources| 1 Duery ge
L3

6. Click the 1:1 (one-to-
one) magnifying glass
under the menu (circled in ,
Figure 10) to return to the W\ LA T
full network view. The V.
view in Figure 12 appears.

You see two gene
products disconnected S
from the network (bottom I -
middle of the view). All

other gene products are

connected, suggesting the | “

pOSSIbIIIty Of Some Ilnk Gene Marme Descripkion Function |

1 CYPTA1 cytochrame P4450, family 7, subfamily A, polypeptid cholesteral F-alpha-monooxygenase activity [G0:00
between II’OFI- and SOATT sterol O-acyltransferase (acyl-Coenzyme A chalest, acyltransferase activity [GO:0008415]; steral O-acylt...
sphingolipid genes.

Figure 12. 2 lipid/cholesterol gene products are disconnected.
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Gaining Insights from Clusters

Steps

Looking for possible links between iron- and sphingolipid related genes, you now explore clusters.
To spot the gene products easily from your original list and their GO associations (iron or
sphingolipid), you will first color code the nodes by these GO distinctions.

1. Color-code the two types of genes with the following steps.

A. Bring in the Excel spreadsheet values for the genes —
“CytoiHemeAndSphingNoHdgReadInList.xIs”

- On the top menu, click File > Import 2> Attribute from Table (Text/MS Excel).
- In the resulting dialogue box follow the steps in Figures 13a-d.

Fle Edit Wiew Select Layout Plugins Help

Mewy 3 ‘-
> @) =
Open Chr4+-0 Q @‘ |
e s S File = Import
Save As... Crrl+Shift+5 jerebral | Edior | . 4| >| .
Network {multiple file bypes)... Cri+L % AttrIbUte from
Export ] Metwork from Table {Text /M3 Excel)... table
PFnE. .. ChH+P Network from web services, .,
Quit Ch+Q Mode Attributes. ..
Attribute from Table
& Import Annotation File x|
e 5
Import Attribute from Table
H 11 » .
vatasources — L Click “Node” Select afile
Attributes (' Node ( Edgs (" Hetwork l
InputFile  fureljMy D Olnfo_Prophchcj) pril09/PriorDisease_CytoTutorialy wdsphinghioHdgReadintist..ds | Select File(s) I

jong [ Show Text File Import Options [ Impart everything (Key is shways ID) [ Case Senskive

reiew YW hen the file is read in, the table shows its data
@) Excel™Workbook Left Click: Enable/Disable cflumn. Right Click: Edit Column Legend: [T BTN

sheet1 | Key Attributes
+« Column 1 | ' Column 2 I " Column 3 | « Column 4 | 10117 ﬂ
cP o008 | 00070 iron home ostatis = 10196
HFE | 0.011 . oo010 iron homeostatis | 10200
SLC3I9A14 | 0.7 0.06 iron homeostatis 10331
FTL | 0.302 0.0070 iron homeostatis =
LcN2 | 085 0.08 iron homeostatis | 10381
TF | 06 | 0.08 iron homeostatis | 10382
UGT1A1 | 0.0010 | 4.0E-4 | iron homeostatis | 10402
NPC2 0.34 0.0080 Cholesterol Homeostatis -
10419
| | > b =
Key Matohed: 0 First 100 enkries are loaded For preview. File: Size: 13 KBytes Irnport ! Cancel

Figure 13a. Step 1 of setting up Import: Keep the default attribute (radio button) on Node;
select the xls file to import.
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& Import Annotation File x|

e :
Import Attribute from Table

Data Sources-
Attributes  + Node ¢ Edge  Network
Input File  firelivty D _ProphCMCJAHMApri03/PrionDisease_CytoTutorial dirlist. s~ Select File(s)

Check “Show Mapping Options”

Mapping Options [~ Show Text File Import Options [~ Import everything (Key is shways ID) [ Case Sensitive.
Annotation File to Attribute Mapping
Key Column in Annotation File Key Attribute for Network

Primary Key: Iah Column 1 LI
Allas?_| Column (Attribute Name) | DataType ™Y |_ I ;]
[ column 1 in String A
I |Colmn 2 23 Float .
T [Comns i o J After checking, a key
™ |Column 4 dpy String n
I Golumns a2 COlUMNS view appears
Preview
1 Rt ek il
! Rt-mouse click <!
— attribute Name anaTyp H@Me Column 1 Gene
¥ — Name. Click OK. 2
 Column 1 | 2 COMN2 | 5y neme For Column 1 antry.
e T Y
SLC39A14 017  Attribute Data Type
FTL 0302 | ! P
LCN2 0.55 1% Stting ¢ Inkeger ¢ Floating Point " Boolean
TF 0.6 et n =
UGTIAT 50010 £ List: |ust of Strings =l
NPC2 0.34 (i Bz i =l
f] =
=  Gther [
Kay Matohed: 0 ||| First 100 entries Cancel
[0 Cancel

Figure 13b. Set up the data fields for a mapping of your file to the data already in Cytoscape.

& Import Annotation File x|
e :
Import Attribute from Table
- Data Sources

Attributes  (+ Node " Edge (" Metwork

Input File |“I\rﬁ.|’|“"¥ Documents/BIOINfo_PropNCMC/AHMARHIDYPricnDisease_CytoTutorialfHemeAndSphingNoHdgReadInList . xls Select File(s) |

~Advanced
[ Show Mapping Options [ Show Text File Import Options [ Import everything (Key is always ID) [ Case Sensitive
Annotation File to Attribute Mapping

Key Column in Annotation File Key Attribute Tor Nej Se I ect G e ne
Primary Key: Iah Gene Name j
_ Name. The data
After you name N ou import will
5 Column 1, it L WP y P
L jem: | appears here [ i e map to Cyto-
- Column4 b Pathway
L fCu\Em:s = e S Ay Component Scape data on
Ap Gene type
Praidowr dpy Other Gene Name: Gene Name
Excel™ Workbook Left Click: Enable/Disable Column, Right cJah Map_loc vl.
Sheet1 | Key Attributes
¥ Gene Name | %’ Column2 | < Column3 +/ Column 4 10117 ﬁl
CP 0.038 0.0070 iron homeostatis «|| 10196
HFE 0.011 0.0010 iron home is 10200
SLC39%A14 0.17 0.06 iron homeostatis 10331
FTL 0.302 0.0070 iron homeostatis L
LCN2 0.55 0.08 iron homeostatis 10381
TF 0.6 0.06 iron homeostatis 10382
UGT1A1 0.0010 4.0E4 iron homeostatis 10402
NPC2 0.34 0.0080 Cholesterol Homeostatis ~
J | S| o e
| Key Matohed: 0 || First 100 entries are loaded for preview. | | File Size: 13 KBytes | Import I Cancel

Figure 13c. Set Gene Name as the primary key — the field on which to map data.
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& Import Annotation File . X

e 5
@ Import Attribute from Table

[ Data Sources
Attributes @ Mode (" Edge  Metwark

Input File  fiirelffy Documents{BIOTnFo_ProphiCMC/AHMARAIDS Fricnbissass_CytoTutorislHemsfndSphingoHdgReadinlist xls  Selset File(s)

[V Show Mapping Options [~ Show Text File Import Options [ Import everything (Key is always 10} [V Case Sensitive
Annotation File to Attribute Mapping
Key Column in Annotation File Key Attribute for Network

Primary Key: Iah Gene Name

L]

Gene Name Ay String ||
p_value A L% Float
p_value B L2 Float
GO term Ay String
Column 5 Ay string L7
Preview
Exc Rt-mouse click to change the rest of the column names. EE
shest1 | l l Key Attributes
+ Gene Name | +/ p valueA | « p_valueB * GO term 10117 ﬁl
CP 0.038 0.0070 ron homeostatis || 10196
HFE 0.011 0.0010 ron homeostatis 10200
SLC39A14 0.17 0.0 ron homeostatis 10331
FTL 0.302 0.0070 ron homeostatis L4
LCN2 0.55 0.0 ron homeostatis 10381
TF 0.6 0.0 ron homeostatis 10382
UGT1AT 0.0010 4.0E-4 ron homeostatis 10402
NPC2 0.34 0.0080 Cholesterol Homeostatis +
10419
< | > i =
| Kay Matched: 0 | | First 100 entries are loaded for preview, | re Click Impol‘ti_’lmpurt Cancel

Figure 13 d. Finish naming the fields and click import.

B. Color Code by the field named GO Term, which simply differentiates between iron- and
sphingolipid/cholesterol related genes.

- Click the VizMapper tab in the Control Panel.

- Follow the steps detailed in Figure 14.
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e

mdaana®
Control Panel ey Steps:

To Metwork | WizMapper™ | Cersbral| Ediar | [ » 9
~Current Visual Style 2

finan =]

~Defauits

On the list,

5. Color code

Mode Border Color

~Visual Mapping Browser

& =

B
= Edge Yisual Mapping ﬂ
Edge Calor

=l Mode Color

Mapping Type

Cholesteral Ho...
Edgellserannot

Sphingolipid Me. ..

= Mode Wisual Mapping

10196

[Swatihez | pyse |
Mode Border Color UserAnnot . Y B [Swatches]] tse | rgs |
L | MNode Line Width L
Mapping Type oo
MNode Shape I Recects
10117 J T

i Welcome to Cytoscape 2.6 5

Click on Node Color. A pull down list appears.

select GO Term.

3. Click on the box next to Mapping type. Click Discrete
Mapping (for categorical data)

4. Click on the “...” next to each value in the field. A color
chart appears.

as shown. Press OK on the color chart.

Userfnnok

GO Term

Discrete Mapping
e —
[se————=]

10200

10331

10351

10352 ;I

Right-click. + drag t

‘Welcome to Cytoscape 2.6.0

Figure 14. Color code by GO Term: Cholesterol and

Sphingolipid = Purple; Iron = Turquoise.

Finding Networks of Interest:

2. From the initial display it is clear that there are genes from both of the major metabolic areas:

Cholesterol / Sphingolipid metabolism and Iron

linked. There are some highly clustered regions around specific pathways, but in addition there are

some other loose clusters that bear examinatio

3. One method for looking for pathways is to ‘browse’ genes and highlight small groups of them
and then use the SAGA tool to find approximate subgraph matches to the input group in the KEGG

pathway database.

a. Use Shift Click to select the following genes
HTR1A
GNA13
ARHGEF12
GNAI1
GNAQ
PRKACA
ARHGEF11

homeostasis, however none of them is directly

n.

which are linked to both EDG3 and ABCAL1.
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EDG3
ABCAl

b. Select all the adjacent edges to these nodes (Click Select - Edges - Select Adjacent
Edges)

SLC39A14..

@
[
|
Gene Name Description Pathway
GHAG guanine nucleotide hinding protein (G protein), g p. Calcium gignaling pathway [path-hea04020], Gap |, GTP hinding [
PRKACA protein kinase, cAMP- , catalytic, alpha MAPK sighaling pattway [pathchsa04010]; Calciurm... | ATF binding [
ARHGEF11 Rho guanine nucleotide exchange factor (GEF) 11 GTPase acliv.
EDG3 , sphingolipid G-pratein-c... | Neuroactive ligand-receptar interaction [pathhsa4... | lipid binding [
ABCA1 ATP-hinding cassette, sub-family A (ABC1), memb.. ABC transporters [path-hea02010] apolipoprotei

c. Right click on EDG3 and launch SAGA (Right Click EDG3 > MiMI Plugin = SAGA - Do
SAGA)

i
Qi;?\_'
o 1903
= Visual Mapping Bypass »
»
Linkout »
Description MetSeape 4 T

Functio
=575];
245

LinkOut NCIBL | What is SAGA? [0
Meuroactive ligand-receplor interaction [pathihsa0d... | lipid binding [50:000828],

uaning nucleotide binding pratsin (G protei
rotein kinase, cAMP-dependent, catalvtic, alpha
tho guanine nucleotide exchange factor (GEF) 11
ndothelial differentiation, sphingolipid G-protein-c..

d. In the popup window — leave the default settings and click “Query”

e. The SAGA results include a table of the possible matching pathways, and the score and number
of nodes from your query pathway against the KEGG database.

The Query Result:

Result for the Query: MiMIPlugin25AGA
‘Tatal Execution Titee (g): 0039039

Nurdser of Matches: 6 (sxcluding self matches)
Matches Overview:

Maich No. Maich Graph Name (4Nodes, #Edges) Graph Distance Matching Nodes
Maich #1 pathihsa04540 (48,56) [Gap junction] 2400 Zomtof8
Maich #2 pathchsal4 730 (35,39) [Lovg-term depression] 24.00 2 omt of 8
Maich 43 pathihsa04 730 (35,39) [Lone-term depression] 24.00 2 omt of 8
Match #4 pathchsa04916 (35,51) [Malanngenesis] 2500 2 omt of 8
Match #5 pathihsall4720 (26,38) [Lone-term potentiation] 2600 2 omt of 8
Maich #6 pathchsall4912 (36,38) [GnRH signaling patway] 2600 Zomtof8
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f. Click on Match #2 to explore the possible matches to the genes you queried.

Co Back io Maiches Overview]

[Match #2: path:hsal4730 (35 nodes, 39 edges) [Long-term depression]

aph Distance 24.00 (2 out of & nodes mateh)

liinie fo KEGE Pirture]/twith the matching nodes highlichtsd)

query: MiMIPlugin2SAGA

DB graph: path:hsa)4730

GRML...

/
y i A N
GNAIS... GNAIL...

g. The cartoon representation of the network shows where your query matched KEGG. To
visualize the KEGG pathway, click on Link to KEGG Picture.

| ] sAGA | 1] sAGa [ KEGG PATHWAY: Gap junction - Homo .. [3 keGs PATHW
[ Pathway menu | Pathway entry ]

Homa sapiens (human) v (=]=]1+)
LONG-TERM DEPRESSION

Parallel fiber Purkinje cell

u
(Gembollun) -
Guey -+ O+ oo | 7——— ,,,,,, 1

i

- |
Ce oy TN S T o T B 7 R ]
A l FPhosphorylation-
: '—b- — == dephosphorylation
ooo © PLAZ Q I/_ (?E’D)gwrmy:;

g |
Pt ° 1
og o 4 ‘
2 I
GM !
|
\d

Porallel fiber AMPARs

Phosphorylation
Inemalization

N
Climhing fiver I }
i I
_— & I
o o !
S0 o — |
Clhuemee = !
500 G i
o - |
I
I
|
1

It is interesting and perhaps useful to discover that the short number of genes involved between
EDG3 (sphingolipids) and ABCA1 (cholesterol synthesis) are also related to genes involved in Long-
Term depression / potentiation of neuronal signaling.

4. Using a Network Based Cluster analysis tool: MCODE

a. Now examine clusters across the whole network without bias. Click the menu item Plugins 2>
MCODE - Start MCODE. The MCODE panel appears on the left Cytoscape Control panel. MCODE
algorithms analyze your network and pull out structural patterns (clusters) that stand out. These
are network structural clusters, not necessarily biological ones. They often, however, represent
shared pathways among the members of the sub-network.
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b. On the MCODE panel, leave the defaults intact and click Analyze. Processing may take a

moment. The MCODE Results panel appears on the right. It presents the most salient (high
scoring) cluster first and the rest in descending order (See Figure 15).

& Cytoscape Desktop (Session: CytoPrionTutorial3_partZ cys) =)
Filz Edt Wew Sslect Layout Phins Help :

5HQQAQ Q8| @ e B s | - 8

ool Pane BB s Coomi - omo soicns Al il 21 x| ResunsPane

s Heswork | vtapper™ | corebeal| Eator [ ) (1| ® ; AMCODE Meooe Resut ||

Find Clustar(s) & # y Chuster Browser

& i Whole Network ¥ i

(" frcen Selection .

Advanced Options p x

Dala Fanel
0 | Geretome | oeseription | Funtion Process | Pathway | Companent |
_--—_'E?.-E-—J Hods Attribute Browser | Edge Atbrb | Newoek At | Parallel Coordnates | VistaClara |
Welcoms b Cytoscaps 2.6.0 RigHE-Cick + drag to 2000 Micko-click + drag to PAN

Figure 15. Run MCODE by Pressing Analyze. The Results appear on the right panel. The Visual
Style has become MCODE Style. To see nodes by gene symbol, return to MiMI Visual Style.

c. Set up the graphics using the following steps as indicated in Figure 16:

Resize the Results panel and network window.

To see Results and the network better, click the Float Window (docking) icon el. The icon is
circled in Figure 16. To re-dock, click the icon again.

Running MCODE changes out of the MiMI Visual Style. Return to the MiMI Style by clicking
the VizMapper tab in the left Control Panel. In VizMapper under Current Visual Style, pull

down the list and click MiMI. MiMI style returns, e.g. gene symbols on the nodes and the
color and shape coding that you are used to.

Return to the Network tab from VizMapper in the left hand Control Panel.
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& Cytoscape Desktop (Session: CytoPrionTutorial3_partZ.cys)
Fie Edt View Sslect Layout Plagns Help
>E Q@ @ 8 @ Move to VizMapper — click arrows if needed
Control Panel “/ B P HFE SLCT9A14... | Home sapiens | All Molecule T =21 x| | Results Panel
t Hs:wcrk1 |Cuehd|[m|..._'u A MCODE mooawnl '
Current Visual Style :{. Me™DE Results
- A Network, 8 ~Detals |
. Click to undock
.-, Undocking will show
L G i “Create Subnetwork
F 205 2t 1
oy 5% Button
i&; e
Visual Mapping Browser » b Lol 4 Edges: 44
[z = W2 |
i 5 = Rarde: 3
E Node Visual Mapping | score: 1.875
B Node Color MCODE_Score - Hodes: @
p= \ Edges: 15
 Mode Shaps MCODE_Node_Status
[ Unused Properties Eil il
Edge Color Data Panel
Edge Fonk Face 2| D g B
Edge Fonkt See D | GeneMame Descgtion | Function | Process | Pottway. | Component |
Edge Label
Edge Label Cokr
Edge Label Opacky
Edge Line Style
Edge Line Width 21 || biode Attriuste Browser | Edge MRbU Browser | Netwerl ARibUtE Browses ] Paralel Cooranatss ] vetsdaa]
Wiedcome [o Cytoscaps 2.6.0 Right-click + drag to Z00M tcia-chek + drag to PAN
Figure 16.

d. Examine each of the clusters extracted by MCODE in turn.

For each cluster, examine the details of its gene products displayed in the Data Panel when you
select the gene products. Try to gain insight into genes that may link iron and sphingolipid. Use
these steps for each successive cluster:

1.

Click on the first cluster image on the Results panel. The Data Panel displays the details
of only these gene products.

Click Create Subnetwork on the MCODE panel to see the network view on the large
graph of just these molecules. The visual style changes.

Consequently, after creating each subnetwork, you will have to reset the view to the
MiMI Visual Style as detailed in Step 4 above and as shown in Figure 16.

When none of the nodes is selected, you can see the color-coding to distinguish iron-
and sphingolipid -related gene products.

Select all the nodes and edges in the subgraph by drawing a box around them or
pressing Control+ Alt+A. The yellow highlighting replaces your color coding.

View the interactions and study the nodes’ Function, Pathway, Component and Process
details. You may see a biological story beginning to take shape as you move through the
different clusters.
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When finished with one cluster, move to the next and repeat these steps. Each cluster is
automatically saved in this Cytoscape session. You can find it listed in the Network tab view
on the left Control Panel (See Figure 17).

& Cytoscape Desktop {Session: CytoPrionTutoriald_partZ.cys) = i‘l‘ ciol:
Flla Edb View Selsct Layout Pugine Help 2
= [ ——— A MCODE MCOOE Resiit |
=HQaQa 8 @- B = | st
Gontrol Panel 8 MCODE Result 1: Cluster 1 (Score: 6) —=
T2 Netvrork | veeppecm| cerebra| Edtor | .. _j_
ook pdes 15t Cluster view
The Network tab view shows each
o Bdges: 44
MCODE network, its # of hodes & edges. _
Each network you dreate, including your /% e 1
original large one, i§ saved and accessible ot =
by clicking Its title lipe in the Network view,
I ) N M!M
Data Pang| 1 Tode Attribute Enumerstor
HOW [[rasss st =l
i e = Ream e | oemme
;;l FU‘;'; _Ir::okmransrerase ;Isg‘c:;mlu s;alus included) | furesyliansferase actiily [30.000
2525 FUT3 fucosyliransferase 3 (aala:tnsme 3[4:»L ru(osyma 3-galaciosyl-N-acetylglucosaminio
2523 | FuTt fucogyltrancferase 1 (galactoside 2-alpha-L- :ucnsyl | fucosyltransferase actity [G0:000
10402 | STIGALE | §T3 heta-galactoside alpha-2,3 | activity (G0 0008
fr{m | B4GALTY | UDP-Gal: beta 1,4- galactos | beta-N-acetyic . =
[ Attribute | Attribute A oordnates a8
Welooms:to Cytostaps 2.6.0 PRight-chok + drag to z’::ﬁwmm ta Pmml = e e o) i‘ el

Figure 17.

Some insights from this exploration of clusters are highlighted in Figure 18:

[— =¥ | 5. Click the Network tab in

MCODE 7 the left Control Panel to

SNTB2 — transport and return to the large network

P i aoeil view. Click the title line of

ABCA1 (original list) — t_he I_arge nt_etwork (the first

cholesterol transporter line in the list of networks).

UTRN (zinc ion) — heavily

documented interactions The large network is

through provenance displayed, with whatever
genes you last selected in

BOg cel the MCODE view

:::D? IEEEE;M sanmnnm ::::f(ﬂ;::::"assnma!eﬂ ﬁmm: I_?:;‘::I:Ug:nmg legoga;!m]j;‘fm[rg ;a]c g;lcg‘uggmm :og: Dnlnggm:g Lu‘; _!muscle cnnnatllﬂn [GO UUDSE%] hlghllghted In ye”OW.

e T

[50
;L.m—* | Edge Attribute Browses | Network Attrbute Bromser | Paralel Coordinates | VistaClara |
Z00M Middle-clck + drag to PAN
Figure 18. MCODE 7 with ABCA1 as a gene of interest

Based on interesting interactions you uncovered from the cluster exploration, see if you can find
indirect links between iron metabolism and sphingolipids or cholesterol.

e. Use the ESP search box to find and select two genes. Then use the “Shortest Path” plug in see
how many hops separate the two genes and view the connectors of the hop.
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f. In the ESP box: Type ABCA1 OR UGT1A1. These two nodes are selected and highlighted.

g. On the top menu, click: Plugins - Shortest Path... > Shortest path undirected.

File Edt View Select Layot Flugins Help

P @‘ Q Q @ @ Search: l:E ESP1 abeal or ugtlal

Caontrol Panel Ul 3 Cp HFE SLC39A14... |Homo sapiens | All Molecule Types|All Data Sources | 1. Query genes + nearest neighbors |

T Metwark. | viMagper™ | .. [,

Network, Nodes | Edges
CP HFE SLC39A1175(4)  S68(3)
4(4) 66}

§ ) Pathfound:
\r’\ Distance between 54658 and 19 is 3 hops.

~ || DataPanel
D Gene hame Description Pathway

80146 UxS1 UDP-glucuronate decatboxylase 1 Pentose and glucuronate interconversions [pathchs... | hinding [G0:0005¢
604 BCLE B-cell CLUAymphoma 6 (Zinc finger protein 513 chromatin hinding
54658 UGT1A1 UDF glucuronosyltransferase 1 family, polypeptide ... | Pentose and glucuranate intercanversions [pathchs... | glucuronosyltranst
19 ABCA1 ATP-hinding cassette, sub-family A (ABC1), memb. ABC transporters [path:hsa02010] apolipoprotein rec
Hode Attributs Browser | Edge Attribute Browser | Network Attribute Browser

Wielrame bn Cufnsrane 7 A1 Rinht-rlick + dvan b 700K Widdlle-rlick + dan t Pan

Figure 19. Shortest path between ABCA1 and UGT1A1 = 3 hops

Three hops in this network include ABCA1 &> BCL6 > UXS1 - UGT1Al. This is a rapid way to
identify the path through a complex network.

SUMMARY:
In this module we have shown you how to:

Part |
» Query on a list of genes
» Set up views to facilitate exploratory analysis, e.g. layouts, selection
» Explore details to conceptually characterize gene products and interactions
» Expand a network node (gene product) to see additional direct interactors
» Find literature associated with interactions to help verify the interactions

Part 11
» Read in additional values related to the genes on your list
» Color code nodes by a selected attribute
» Link out to details, supporting literature, and subgraph matches with KEGG
» Find shortest paths between 2 genes and identify the mediating gene products
» Create network clusters and explore their traits
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